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Preface

Audience and Use

The User Workstation Setup Guide for Cisco Unity Connection contains information and instructions
that system administrators can use for setting up user workstation access to Cisco Unity Connection web
tools, for configuring email accounts to access Connection voice messages, and for conducting
orientation sessions for users.

Documentation Conventions

Table 1 Conventions in the User Workstation Setup Guide for Cisco Unity Connection
Convention Description
boldfaced text Boldfaced text is used for:

e Key and button names. (Example: Select OK.)

e Information that you enter. (Example: Enter Administrator
in the Username box.)

<> Angle brackets are used around parameters for which you supply
a value. (Example: In your browser, go to https://<Cisco Unity

(angle brackets) N N
Connection server IP address>/cuadmin.)

- Hyphens separate keys that must be pressed simultaneously.
(hyphen) (Example: Press Ctrl-Alt-Delete.)

> A right angle bracket is used to separate selections that you make
in the navigation bar of Cisco Unity Connection Administration.
(Example: In Cisco Unity Connection Administration, expand
Contacts > System Contacts.)

(right angle bracket)

The User Workstation Setup Guide for Cisco Unity Connection also uses the following conventions:

Note  Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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Preface |

e

ﬁ Means the following information may help you solve a problem.

A

Caution = Means reader be careful. In this situation, you might do something that could result in equipment damage
or loss of data.

Cisco Unity Connection Documentation

For descriptions and URLs of Cisco Unity Connection documentation on Cisco.com, see the
Documentation Guide for Cisco Unity Connection. The document is shipped with Connection and is
available at http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/roadmap/8xcucdg.html.

Documentation References to Cisco Unified Communications Manager
Business Edition

The name of the product known as Cisco Unified Communications Manager Business Edition in
versions 8.0 and earlier has been changed to Cisco Unified Communications Manager Business Edition
5000 in versions 8.5 and later.

In the Cisco Unity Connection 8.x documentation set, references to “Cisco Unified Communications
Manager Business Edition” and “Cisco Unified CMBE” apply to both Business Edition version 8.0 and
to Business Edition 5000 versions 8.5 and later. The references do not apply to Business Edition 6000.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS Version 2.0.

Cisco Product Security Overview

This product contains cryptographic features and is subject to United States and local country laws
governing import, export, transfer and use. Delivery of Cisco cryptographic products does not imply
third-party authority to import, export, distribute or use encryption. Importers, exporters, distributors
and users are responsible for compliance with U.S. and local country laws. By using this product you
agree to comply with applicable laws and regulations. If you are unable to comply with U.S. and local
laws, return this product immediately.

Further information regarding U.S. export regulations can be found at
http://www.access.gpo.gov/bis/ear/ear_data.html.

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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CHAPTER 1

Setting Up Access to the Cisco Personal
Communications Assistant in Cisco Unity
Connection 8.x

Revised November 16, 2010

The Cisco Personal Communications Assistant (PCA) is installed on the Cisco Unity Connection server
during installation. It is a website that provides users with access to the Cisco Unity web tools, which
allow users to manage messages and personal preferences in Connection. The web tools available in the
Cisco PCA include:

e Cisco Unity Connection Messaging Assistant
e (Cisco Unity Connection Messaging Inbox (in Connection 8.0)
¢ Cisco Unity Connection Personal Call Transfer Rules

To learn more about the tools listed above, see the applicable User Guide for Cisco Unity Connection
and the Help for each tool.

See the following sections:
e Configuring a Web Browser to Access the Cisco PCA in Cisco Unity Connection 8.x, page 1-1
e Changing the GUI Language for the Cisco PCA in Cisco Unity Connection 8.x, page 1-3

e Customizing the Cisco Unity Connection 8.0 Messaging Inbox for a Low-Bandwidth Deployment,
page 1-3

e Managing Security Alerts When Using Self-Signed Certificates with SSL Connections in
Cisco Unity Connection 8.x, page 1-4

Configuring a Web Browser to Access the Cisco PCA in
Cisco Unity Connection 8.x

The browsers on each user workstation must be set up to use the Cisco PCA and the Cisco Unity
Connection web tools. See the applicable section, depending on the browser installed on the computer:

e Apple Safari, page 1-2
e Microsoft Internet Explorer, page 1-2

¢ Mozilla Firefox, page 1-2

User Workstation Setup Guide for Cisco Unity Connection Release 8.x i



Chapter1  Setting Up Access to the Cisco Personal Communications Assistant in Cisco Unity Connection 8.x |
Il Configuring a Web Browser to Access the Cisco PCA in Cisco Unity Connection 8.x

(For the list of versions supported for each browser, see the Compatibility Matrix: Cisco Unity
Connection and the Software on User Workstations, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/compatibility/matrix/cucclientmtx.html

Y

Apple Safari

Do the following tasks to set up Safari for accessing the Cisco PCA.

1. Confirm that the software required for correct browser configuration is installed. See the “Software
Requirements—User Workstations” section of the System Requirements for Cisco Unity Connection
Release 8.x, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html

2. Configure Safari:
a. Enable Java.
b. Enable Java Script.

c. Accept cookies only from sites that you navigate to.

Microsoft Internet Explorer

Do the following tasks to set up Internet Explorer for accessing the Cisco PCA.

1. Confirm that the software required for correct browser configuration is installed. See the “Software
Requirements—User Workstations” section of the System Requirements for Cisco Unity Connection
Release 8.x, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html

2. Configure Internet Explorer:
a. Enable Active scripting.

b. Download and run ActiveX controls.

c. Enable Java scripting.
d. Accept all cookies.
e. Automatically check for newer versions of temporary Internet files.

f. Enable Medium-High privacy.

Mozilla Firefox

Do the following tasks to set up Firefox for accessing the Cisco PCA.

1. Confirm that the software required for correct browser configuration is installed. See the “Software
Requirements—User Workstations” section of the System Requirements for Cisco Unity Connection
Release 8.x, available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.html
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2. If users are running Firefox on Apple MAC OS X or Microsoft Windows workstations, skip to
Task 3.

If users are running Firefox on Linux Red Hat workstations, confirm that they are using the correct
sound card by referring to the sound card support matrix on the Alsa-project.org website. (Note that
the Java Runtime Environment (JRE) plug-in software uses the Advanced Linux Sound Architecture
(ALSA) driver to access system sound devices and to control playback and recording functionality.
Depending on the sound card, playback and recording capabilities may be limited.)

3. Configure Firefox:
a. Enable Java.
b. Enable Java Script > Enable Change Images in Java Script Advanced.

c. Allow sites to set cookies. (For security purposes, we recommend that you set this to Allow
Sites to Set Cookies for the Originating Web Site Only.)

Changing the GUI Language for the Cisco PCA in Cisco Unity
Connection 8.x

Revised November 16, 2010
Do the following tasks to change the GUI language that is used in the Cisco PCA.

1. Download and install the applicable languages. For instructions, see the applicable documentation:

e For a new Connection server, see the “Installing Additional Languages on the Cisco Unity
Connection 8.x Server” chapter of the Installation Guide for Cisco Unity Connection at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/installation/guide/8xcucigx.
html.

e For an existing Connection server, see the “Adding or Removing Cisco Unity Connection 8.x
Languages” chapter of the Reconfiguration and Upgrade Guide for Cisco Unity Connection at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/upgrade/guide/8xcucrugx.ht
ml.

2. On the user workstation, select a language in the web browser. The language selected in the browser
must be one of the languages that the Cisco PCA offers and it must be installed on the Connection
server. For a list of supported languages, see the “Available Languages for Cisco Unity Connection
Components” section of the applicable System Requirements document:

e System Requirements for Cisco Unity Connection Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucsysreqs.
html

e System Requirements for Cisco Unity Connection in Cisco Unified CMBE Release 8.x at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/requirements/8xcucmbesysr
eqs.html

Customizing the Cisco Unity Connection 8.0 Messaging Inbox for
a Low-Bandwidth Deployment

Revised November 16, 2010

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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If users play recordings by using computer speakers in a low-bandwidth deployment (for example, with
a slow modem or in a branch office), they should download messages before playing them for best
performance and quality.

To customize the Cisco Unity Connection Messaging Inbox (in Connection 8.0) so that messages are
downloaded rather than streamed from the Connection server during playback, do the following
procedure to change the Performance setting on each user workstation (as applicable).

To Customize the Cisco Unity Connection 8.0 Messaging Inbox to Download Messages Before Playing Them

Step 1 On the Cisco PCA Home page, select the Messaging Inbox link.

Step2 In the Messaging Inbox, go to a page that contains the Media Master. (For example, select the New
Message icon to open a new message window.)

Step3  On the Media Master Options menu, select Playback & Recording.

Step4  In the Playback and Recording Settings dialog box, under Performance, select Download Complete
Message Before Playing.

Step5 Select OK.

Managing Security Alerts When Using Self-Signed Certificates
with SSL Connections in Cisco Unity Connection 8.x

If you use the self-signed certificate generated during installation to provide an SSL connection to the
Cisco PCA, the web browser of the user displays a message to alert the user that the authenticity of the
site cannot be verified, and therefore its content cannot be trusted. Similarly, if you use a self-signed SSL
certificate to secure IMAP email client access to Connection, some email clients supported for use with
Connection display SSL security messages.

Although users can still access Connection despite the alerts, consider one of the following options to
manage or eliminate security alerts when users browse to the Cisco PCA and/or access their messages
from an IMAP email client:

e Add the SSL certificate to the Trusted Root Store on each user workstation. In this way, you can
ensure that users never see the security alert. Do the following “To Add the SSL Certificate to the
Trusted Root Store on User Workstations” procedure.

e Tell users to choose the “Accept Permanently” (or similar) option when the browser or email client
displays the alert and asks them how to proceed. After instructing the browser and/or email client to
always accept the certificate, the user will not see the alert again.

Do the following procedure if you want users to never see the security alert.

To Add the SSL Certificate to the Trusted Root Store on User Workstations

Step 1 From the OS Administration application on the Cisco Unity Connection server, right-click to download
the certificate and save it as a file.

Step2  Copy the certificate to each user workstation, and then import it by using tools in the browser or IMAP
client, as applicable.

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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CHAPTERZ

Setting Up Playback and Recording Devices for
the Media Master in Cisco Unity Connection 8.x

The Media Master is used to make and play recordings in the Cisco Unity Connection web tools.

See the following sections:

e About the Cisco Unity Connection 8.x Media Master, page 2-1

e Determining Which Recording and Playback Devices Users Will Use for the Media Master in
Cisco Unity Connection 8.x, page 2-2

e How Users Specify Their Recording and Playback Device Preferences in Cisco Unity Connection

8.X, page 2-3

About the Cisco Unity Connection 8.x Media Master

Revised November 16, 2010

The Media Master appears on the pages of the Cisco Unity Connection Messaging Inbox (in Connection
8.0) and Cisco Unity Connection Personal Call Transfer Rules web tools on which users can make or
play recordings. Depending on how Cisco Unity Connection is set up, the Media Master may also appear
on some Connection Messaging Assistant pages. Users can use the phone or the computer microphone
and speakers with the Media Master controls to make and play recordings. See Figure 2-1.

Figure 2-1 Media Master
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I Determining Which Recording and Playback Devices Users Will Use for the Media Master in Cisco Unity Connection

Note

1 |Options menu 71 |Stop

2 |Recording/playback progress 8 |Pause

3 |Record list 9 |Play

4 |Help menu 10 | Volume control
5 |Playback speed control 11 |Playback list

6 |Record

The Media Master is a Java 2 Platform, Standard Edition (J2SE) application, and the Java plug-in
component must be installed on the user workstation for it to run properly.

Depending on the web browser, if the Java plug-in component is not installed, the Media Master does
not appear in the browser window or the user is prompted to install the component. (See the “Configuring
a Web Browser to Access the Cisco PCA in Cisco Unity Connection 8.x” section on page 1-1.)

Before users start using the Cisco Unity Connection web tools that offer the Media Master, specify that
Connection has at least one voice messaging port designated to allow users to use the phone as a
recording and playback device, by adjusting the Allow TRAP Connections setting on the Telephony
Integrations > Port page in Cisco Unity Connection Administration. See the “Changing Port Settings”
section in the “Managing the Phone System Integrations in Cisco Unity Connection 8.x” chapter of the
System Administration Guide for Cisco Unity Connection Release 8.x for instructions. (The guide is
available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.htm
1.) Alternatively, provide sound cards, earphones or speakers, and microphones to users who do not want
to use the phone as their recording and playback device.

Determining Which Recording and Playback Devices Users
Will Use for the Media Master in Cisco Unity Connection 8.x

When determining the recording and playback devices that you want users to use, note the following
considerations:

e The phone offers the best sound quality for recordings, and serves as the default recording and
playback device for the Media Master.

e Inorder for users to use the phone as a recording and playback device, Cisco Unity Connection must
have at least one voice messaging port designated for this purpose. Note that when a user listens to
messages or other recordings by using a computer microphone and speakers, no ports are used,
which decreases the load on the Connection server and leaves ports open for other functions.

¢ You must provide sound cards, speakers, and microphones to users who do not want to use the phone
as their recording and playback device.

See the following sections for detailed descriptions of the events that occur when using the phone or the
computer microphone and speakers for recording and playback:

e What Happens When the Phone Is Used as the Recording and Playback Device, page 2-3

e What Happens When a Computer Microphone and Speakers Are Used as the Recording and
Playback Devices, page 2-3

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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What Happens When the Phone Is Used as the Recording and Playback Device

When users use the phone as a recording and playback device in the web tools that are accessed through
the Cisco PCA (and in Cisco Unity Connection Administration), the following events occur:

1. The user selects the applicable option in the client application to make or play a recording.

2. The client application asks Cisco Unity Connection to place a call to the user extension, and
Connection calls the extension.

3. When making a recording, the user answers the phone, and begins recording the message, name, or
greeting. When the user hangs up, the client application tells Connection that the recording is
finished.

4. When playing a recording, the user answers the phone, and the client application asks Connection
to play the message. Connection streams the recording by phone.

What Happens When a Computer Microphone and Speakers Are Used as the
Recording and Playback Devices

When users use a computer microphone and speakers as the recording and playback devices, the
following events occur:

1. The user selects the applicable option in the client application to make or play a recording.

2. When making a recording, the user begins speaking into the microphone. When the user selects the
applicable option in the client application to stop recording, the client application tells Cisco Unity
Connection that the recording is finished.

3. When playing a recording, Connection streams the message to the client application. Streaming
occurs on demand, regardless of network traffic. The client application begins to play the message
through the speakers as soon as a few seconds of the message are buffered in memory on the user
workstation.

How Users Specify Their Recording and Playback Device
Preferences in Cisco Unity Connection 8.x

Users can set their own recording and playback device preferences. For example, the Options menu in
the Media Master allows users to choose their own recording and playback devices.

Media Master recording and playback settings are saved per user, per workstation. This means that:

e A user can change recording and playback devices from the Options menu and from both the
Playback and Record lists of any Media Master on the web-tool pages. The recording and playback
devices that a user chooses apply to all Cisco Unity Connection web tools, as long as the user
accesses the applications from the same workstation on which the changes were initially made.

e If multiple users share the same workstation, each user who uses the workstation must indicate a
choice of recording and playback devices.

e If a user has updated the choice of recording and playback devices from one workstation but also
accesses the web tools on a different workstation (for example, from a computer at home), the choice
of recording and playback devices must be set for the second workstation as well.

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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Note

CHAPTER

Configuring an Email Account to Access
Cisco Unity Connection 8.x Voice Messages

Cisco Unity Connection allows licensed users to use a third-party IMAP client to access voice messages
from their desktop machines. You can also forward voice messages with text and reply to voice messages
with text; the text portion of the message is accessible through the Connection text-to-speech feature.

See the following sections:
e Considerations When Configuring IMAP Email Clients in Cisco Unity Connection 8.x, page 3-2

¢ Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Apple Mail,
page 3-2

e Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Eudora, page 3-4

¢ Creating and Configuring an Account to Access Cisco Unity Connection 8.x in IBM Lotus Notes,
page 3-5

¢ Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Microsoft Outlook,
page 3-6

e Setting Up ViewMail for Outlook in Cisco Unity Connection 8.x, page 3-9

¢ Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Microsoft Outlook
Express, page 3-11

e Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Novell GroupWise,
page 3-13

¢ Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Opera, page 3-14

e (Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Thunderbird,
page 3-16

e Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Windows Mail for
Windows Vista, page 3-17

e Troubleshooting IMAP Client Sign-In Problems in Cisco Unity Connection 8.x, page 3-18

When users change their Cisco Personal Communications Assistant (PCA) password (also known as the
web-application password) in the Connection Messaging Assistant, they also must update the password
in their IMAP client application. Passwords are not synchronized between IMAP clients and the

Cisco PCA. If users have trouble receiving voice messages in an IMAP client even after updating their
Cisco PCA password in both applications, see the “Troubleshooting IMAP Client Sign-In Problems in
Cisco Unity Connection 8.x” section on page 3-18.
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Considerations When Configuring IMAP Email Clients in
Cisco Unity Connection 8.x

Note the following considerations when configuring IMAP email clients to access Cisco Unity
Connection voice messages:

¢ In Cisco Unity Connection Administration, configure the following settings on the System
Settings > SMTP Configuration > Server page to match the SSL settings in the IMAP email clients:

— Allow Connections From Untrusted IP Addresses
— Require Authentication From Untrusted IP Addresses
— Transport Layer Security From Untrusted IP Addresses Is (Disabled, Required, Optional)

For more information on these settings, see the “SMTP Server Configuration” section in the
“System Settings in Cisco Unity Connection 8.x” chapter of the Interface Reference Guide for
Cisco Unity Connection Administration Release 8.x, at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/gui_reference/guide/8xcucgrgx.
html.

e IMAP email clients all include two fields in which you can enter either the IP address or the fully
qualified domain name of the Connection server. When a Connection cluster is configured, enter the
fully qualified domain name of a DNS A record that includes the Connection publisher and
subscriber servers. If your DNS server allows you to specify the order in which DNS tries to contact
Connection servers, specify that the server that is available most often is the first server contacted.
This usually is the publisher server.

Some IMAP email clients do not respect DNS A records. For those clients, if the first Connection
server is not available, the client does not try to access the other Connection server.

e  When a user forwards or replies to a voice message from an IMAP email client, the message will be
sent to recipients on the Connection server unless the user specifically configures the message to be
sent through another account.

See the “Configuring IMAP Settings in Cisco Unity Connection 8.x” chapter of the System
Administration Guide for Cisco Unity Connection Release 8.x for additional details. The guide is
available at

http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.htm
L.

Creating and Configuring an Account to Access Cisco Unity
Connection 8.x in Apple Mail

To use Apple Mail to access Cisco Unity Connection voice messages, create and configure a new Apple
Mail account for the user. You need the following information:

e (Connection username (alias).

e Cisco Personal Communications Assistant (PCA) password. (This is the web application password
that is set on the User pages in Cisco Unity Connection Administration.)

e The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.
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To Create and Configure a New Account in Apple Mail

Start Apple Mail.

In Apple Mail, on the Mail menu, select Preferences.

At the top of the Preferences dialog box, select Accounts.

In the lower left corner, select +.

In the Account Type list, select IMAP.

In the Description field, enter a name for the account. This name appears only in Apple Mail.

In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the
Connection server. You can find this information in the SMTP Address field on the User Basics page in
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>
In the Full Name field, enter the username.

In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the
Connection server.

A

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured
for the network.

In the User Name field, enter the Connection username.
In the Password field, enter the Cisco PCA password.

In the Outgoing Mail Server (SMTP) field, select the IP address or the fully qualified domain name of
the Connection server.

Select Server Settings.

Optionally, in the SMTP Server Options dialog box, check the Use Secure Sockets Layer (SSL) check
box.

A

Caution  If you do not configure Apple Mail to use SSL, the Connection username and password that
are sent to Connection over the network and the voice messages sent back from Connection
are not encrypted.

In the Authentication list, select Password.

Select OK to close the SMTP Options dialog box.

Select the Advanced tab.

In the Keep Copies of Messages for Offline Viewing list, select the applicable option.
Close the Preferences dialog box.

In the Save Changes dialog box, select Save.
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Creating and Configuring an Account to Access Cisco Unity
Connection 8.x in Eudora

Step 1
Step 2
Step 3
Step 4

Step 5

Step 6
Step 7
Step 8
Step 9

Step 10
Step 11
Step 12
Step 13

Step 14
Step 15
Step 16
Step 17
Step 18

To use Eudora to access Cisco Unity Connection voice messages, create and configure a new Eudora
account for the user. You need the following information:

e (Connection username (alias).

e Cisco Personal Communications Assistant (PCA) password. (This is the web application password
that is set on the User pages in Cisco Unity Connection Administration.)

e The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Eudora

Start Eudora.
On the Eudora Tools menu, select Personalities.
Right-click anywhere in the Personalities tab, and select New.

In the New Account wizard, on the Account Settings page, select Next to accept the default value, Create
a Brand New E-Mail Account.

On the Personality Name page, enter a display name for the account. The value that you enter here is
visible only in Eudora.

Select Next.
On the Personal Information page, enter the username.
Select Next.

On the E-Mail Address page, enter the Connection SMTP Address of the user and the name of the
Connection server. You can find this information in the SMTP Address field on the User Basics page in
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>
Select Next.

On the User Name page, enter the Connection username.

Select Next.

On the Incoming E-Mail Server page, enter the IP address or the fully qualified domain name of the
Connection server.

A

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured
for the network.

For the type of server, select IMAP.

Select Next.

On the IMAP Location Prefix page, do not enter a value.
Select Next.

On the Outgoing E-Mail Server page, enter the IP address or the fully qualified domain name of the
Connection server.
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Creating and Configuring an Account to Access Cisco Unity Connection 8.x in IBM Lotus Notes 1l

Select Next.

On the Success page, select Finish to create the account and close the wizard.

In the Enter Password dialog box, enter the Cisco PCA password of the user.

Select OK.

Optionally, configure the new account to use SSL. For more information, see Eudora Help.

A

Caution  If you do not configure Eudora to use SSL, the Connection username and password that are
sent to Connection over the network and the voice messages sent back from Connection are
not encrypted.

Creating and Configuring an Account to Access Cisco Unity
Connection 8.x in IBM Lotus Notes

A

Caution

A

If you plan to configure user accounts to use Cisco Unity Connection ViewMail for IBM Lotus Notes,
do not follow the instructions in this section. Instead, follow the configuration instructions in the Release
Notes for Cisco Unity Connection ViewMail for IBM Lotus Notes, available at
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

To use Notes to access Cisco Unity Connection voice messages, create and configure a new Notes
account for the user. You need the following information:

e Connection username (alias).

e Cisco Personal Communications Assistant (PCA) password. (This is the web application password
that is set on the User pages in Cisco Unity Connection Administration.)

e The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

Caution  When using Lotus Notes version 7.x to access Connection voice messages, you must first configure

Notes to connect to a Domino account before configuring the Connection account.
To Create and Configure a New Account in IBM Lotus Notes

Step 1 Start IBM Lotus Notes.

Step 2 On the Notes File menu, select Preferences > Client Reconfiguration Wizard.

Step3  In the Lotus Notes Client Configuration wizard, on the Additional Services page, check the Internet
Mail Servers (POP or IMAP, SMTP) check box.

Step4  Select Next.

Step5  On the Set Up Internet Mail page, in the Select the Type of Server Used for Retrieving Incoming Mail
list, select IMAP.

Step6  In the Enter a New Account Name list, select Incoming Internet Mail.

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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Step 7

Step 8
Step 9

Step 10
Step 11

Step 12
Step 13

Step 14

Step 15
Step 16

Step 17
Step 18
Step 19

In the Incoming Mail Server field, enter the IP address or the fully qualified domain name of the
Cisco Unity Connection server.

A

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured
for the network.

Select Next.

On the Set Up Internet Mail page, in the Account Name field, enter the Connection SMTP Address of
the user and the name of the Connection server. You can find this information in the SMTP Address field
on the User Basics page in Cisco Unity Connection Administration. The Account Name typically
follows this format:

<alias>@<fully qualified domain name of the Connection server>
In the Password fields, enter and confirm the Cisco PCA password of the user.

If you want to encrypt voice messages and other data that are sent between Notes and Connection, check
the Log On Using SSL check box. If not, skip to Step 12.

A

Caution  If you do not configure Notes to use SSL, the Connection username and password that are sent
to Connection over the network and the voice messages that are sent back from Connection
are not encrypted.

Select Next.

On the second Set Up Internet Mail page, in the Enter a New Account Name list, select Outgoing
Internet Mail.

In the Outgoing SMTP Mail Server list, enter the IP address or the fully qualified domain name of the
Connection server.

Select Next.

On the third Set Up Internet Mail page, in the E-Mail Address field, enter the Connection alias of the
user and the name of the Connection server. Use the following format:

<alias>@<fully qualified domain name of the Connection server>

In the Internet Domain field, enter the Internet domain name of the Domino mail server.
Select Next.

Select OK.

Creating and Configuring an Account to Access Cisco Unity
Connection 8.x in Microsoft Outlook

Revised November 16, 2010
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A

Caution  If you plan to configure user accounts to use Cisco ViewMail for Microsoft Outlook 8.5 or later, do not
follow the instructions in this section. Instead, follow the configuration instructions in the applicable
Release Notes for Cisco ViewMail for Microsoft Outlook, available at
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

To use Outlook to access Cisco Unity Connection voice messages, create and configure a new Outlook
account for the user. You need the following information:

¢ Connection username (alias).

e (Cisco Personal Communications Assistant (PCA) password. (This is the web application password
that is set on the User pages in Cisco Unity Connection Administration.)

e The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

In addition to configuring Outlook to access Connection voice messages, you can also install the optional
ViewMail for Outlook plug-in. See the “Setting Up ViewMail for Outlook in Cisco Unity Connection
8.x” section on page 3-9.

To Create and Configure a New Account in Qutlook

Step 1 Start Outlook.

Step 2 On the Outlook Tools menu, select E-Mail Accounts.

Step 3 In the E-Mail Accounts wizard, select Add a New E-Mail Account.
Step4  Select Next.

Step5  On the Server Type page, select IMAP.

Step6  Select Next.

Step7  Enter values in the User Information section:

a. Inthe Your Name field, enter a display name for the account. The value that you enter here is visible
only in Outlook.

b. In the E-Mail Address field, enter one of the following:

e The Connection SMTP Address of the user and the name of the Connection server. You can find
this information in the SMTP Address field on the User Basics page in Cisco Unity Connection
Administration. The E-Mail Address typically follows this format:

<alias>@<SMTP domain name of the Connection server or cluster>
e The proxy address for the user.
Step8  Enter values in the Server Information Section:

a. In the Incoming Server field, enter the IP address or the fully qualified domain name of the
Connection server.

A

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured
for the network.

b. In the Outgoing Server field, select the IP address or the fully qualified domain name of the
Connection server.

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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Step 9

Step 10

Step 11
Step 12
Step 13

Step 14
Step 15

Step 16
Step 17
Step 18
Step 19
Step 20
Step 21
Step 22
Step 23
Step 24
Step 25

Enter values in the Logon Information section:
a. In the User Name field, enter the Connection username.
b. In the Password field, enter the Cisco PCA password of the user.

c. Verify that the Remember Password check box is not checked. If this option is checked, and the
Connection password of the user expires, changes, or is locked, Microsoft Outlook does not prompt
the user to enter the Connection password. The result is that users do not receive voice messages
from Connection.

If you do not want to encrypt voice messages and other data that are sent over the network between
Outlook and Connection, skip to Step 15.

A

Caution  If you do not configure Outlook to use SSL, the Connection username and password that are
sent to Connection over the network and the voice messages sent back from Connection are
not encrypted.

If you want to encrypt voice messages and other data that are sent between Outlook and Connection,
continue with Step 11.

Select More Settings.
In the Internet E-Mail Settings dialog box, select the Advanced tab.

Under Incoming Server (IMAP), check the This Server Requires an Encrypted Connection (SSL)
check box.

Select OK to close the Internet E-Mail Settings dialog box.

If the Connection SMTP server is configured to allow connections from untrusted IP addresses, skip to
Step 21.

If the Connection SMTP server is configured to require authentication from untrusted IP addresses,
continue with Step 16.

Select More Settings.

In the Internet E-Mail Settings dialog box, select the Qutgoing Server tab.

Verify that the My Outgoing Server (STMP) Requires Authentication check box is checked.
Verify that Use Same Settings as My Incoming Mail is selected.

Select OK to close the Internet E-Mail Settings dialog box.

Select Next.

Select Finish.

In the left pane of Outlook, select the Inbox folder for the new account.

On the Outlook Tools menu, select Send/Receive > This Folder.

If prompted, enter the Connection username and Cisco PCA password.
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Setting Up ViewMail for Outlook in Cisco Unity Connection 8.x

Cisco ViewMail for Microsoft Qutlook 8.5 and Later

Added November 16, 2010

To install and set up Cisco ViewMail for Microsoft Outlook 8.5 or later, see the applicable Release Notes
for Cisco ViewMail for Microsoft Outlook at
http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html.

Cisco Unity Connection ViewMail for Microsoft Outlook 8.0

Revised November 16, 2010
By using ViewMail for Outlook 8.0 to access Cisco Unity Connection voice messages, users can play
and record voice messages by using the Media Master. See Figure 3-1.

Figure 3-1 Media Master
Click to stop recording or playback.  Click to recod.
Clicktosekct—w | e B & ) | '-:I‘:‘”:":‘ﬁ
recording and playback | 0.0 0.0 “Yolume _p -Ir Ak
devices, orto copy of valme.
paste recordings. Indicates the length of the
reconding and where you 3
Click to play a recording. are in the reconding. E

See the following sections:
e Task List for Setting Up ViewMail for Outlook 8.0, page 3-9
¢ Configuring the IMAP Account for ViewMalil for Outlook 8.0, page 3-10
¢ Configuring ViewMail for Outlook 8.0 Settings for Secure Messaging and TRAP, page 3-10

Task List for Setting Up ViewMail for Outlook 8.0

Revised November 16, 2010
ViewMail must be installed on each user workstation. Complete the following tasks to set up ViewMail
8.0 for users:

1. Review the applicable Release Notes for Cisco Unity Connection ViewMail for Microsoft Outlook,
available at http://www.cisco.com/en/US/products/ps6509/prod_release_notes_list.html. The
document specifies the requirements and procedures for installing 8.0.

2. If you have not already done so, install ViewMail 8.0 according to the procedures in the Release
Notes for Cisco Unity Connection ViewMail for Microsoft Outlook.

3. If you have not already done so, configure an IMAP account in Microsoft Outlook. See the “Creating
and Configuring an Account to Access Cisco Unity Connection 8.x in Microsoft Outlook™ section
on page 3-6.
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4. If users have more then one IMAP account configured, you must configure ViewMail 8.0 to use the
IMAP account that is used to access Connection. See the “Configuring the IMAP Account for
ViewMail for Outlook 8.0” section on page 3-10.

5. If you use secure messaging or TRAP, you must configure several ViewMail 8.0 settings. See the
“Configuring ViewMail for Outlook 8.0 Settings for Secure Messaging and TRAP” section on
page 3-10.

Configuring the IMAP Account for ViewMail for Qutlook 8.0

Revised November 16, 2010

If users have more than one IMAP account configured, you must configure ViewMail 8.0 to use the
IMAP account that is used to access Connection. This ensures that messages composed by using
ViewMail are sent to the Connection server. If users have only one IMAP account configured, ViewMail
automatically uses it to send messages to Connection.

Do the following procedure on each user workstation.

To Configure ViewMail for Outlook 8.0 Settings

Step 1 From the Outlook Tools menu, select ViewMail Options.
Step2  Select the Accounts tab.

Step3  In the Select the Account to Access Cisco Unity Connection With field, select the IMAP account that is
used to access Connection.

Step4  Select Save.

Configuring ViewMail for Outlook 8.0 Settings for Secure Messaging and TRAP

Revised November 16, 2010

If you have configured Connection for secure messaging or if you want users to be able to record or play
messages by phone by using Telephone Record and Playback (TRAP), you must configure several
ViewMail 8.0 settings.

After ViewMail 8.0 has been installed, do the following procedure on each user workstation.

To Configure ViewMail for OQutlook 8.0 Secure Message and TRAP Settings
Step 1 From the Outlook Tools menu, select ViewMail Options.

Step2  Select the Server tab.
Step3  Enter the following settings:

Table 3-1 Server Settings

Field Setting

Cisco Unity Connection Enter the name of the Connection server. (Required for secure messaging
Server Name and TRAP.)

Username Enter the Connection username (alias).
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Table 3-1 Server Settings (continued)
Field Setting
Password (Optional) Enter the Cisco PCA password (also known as the

web-application password) of the user. If you do not enter the password,
the user is prompted for it each time Outlook is restarted. If you do not
want the user to be prompted for the password each time Outlook is
restarted, you must also check the Remember Password check box.

Remember Password (Optional) Check this check box if you want ViewMail to remember the
user password so that the user does not have to re-enter it each time
Outlook is restarted.

Proxy Server Address If you have a firewall that blocks HTTPS traffic between user
workstations and the Connection server, enter the IP address of the
HTTPS proxy server.

Proxy Server Port If you have a firewall that blocks HTTPS traffic between user
workstations and the Connection server, enter the server port to use when
connecting to the HTTPS proxy server.

Validate HTTPS Certificate |If you replace the default self-signed certificate with a certificate from a
certificate authority, check the Validate HTTPS Certificate check box.

If you are using the default certificate installed with Connection, this
check box must not be checked.

For details, see the “Configuring SSL in Cisco Unity Connection 8.x”
chapter of the System Administration Guide for Cisco Unity Connection
Release 8.x, at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/admi
nistration/guide/8xcucsagx.html.

Extension Enter the extension of the user.

This setting is required only if you want the user to be able to record or
play messages by phone.

Step4  Select Save.

Creating and Configuring an Account to Access Cisco Unity
Connection 8.x in Microsoft Outlook Express

To use Outlook Express to access Cisco Unity Connection voice messages, create and configure a new
Outlook Express account for the user. You need the following information:

¢ Connection username (alias).

e Cisco Personal Communications Assistant (PCA) password. (This is the web application password
that is set on the User pages in Cisco Unity Connection Administration.)

e The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9
Step 10

Step 11

Step 12

Step 13
Step 14

Step 15

Step 16
Step 17
Step 18
Step 19
Step 20
Step 21
Step 22

To Create and Configure a New Account in Qutlook Express

Start Outlook Express.

On the Outlook Express Tools menu, select Accounts.

In the Internet Accounts dialog box, select the Mail tab.

Select Add > Mail, and the Internet Connection wizard appears.

On the Your Name page, in the Display Name field, enter the username.

Select Next.

On the Internet E-Mail Address page, select I Already Have an E-Mail Address That I'd Like to Use.

In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the
Connection server. You can find this information in the SMTP Address field on the User Basics page in
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>
Select Next.

On the E-Mail Server Names page, in the My Incoming Mail Server Is a <protocol> Server list, select
IMAP.

In the Incoming Mail (POP3, IMAP, or HTTP) Server field, enter the IP address or the fully qualified
domain name of the Connection server.

A

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured
for the network.

In the Outgoing Mail (SMTP) Server field, enter the IP address or the fully qualified domain name of
the Connection server.

Select Next.

On the Internet Mail Logon page, in the Account Name and Password fields, enter the Connection
username and Cisco PCA password.

Verify that the Remember Password check box is not checked.

If this option is checked, and the Connection password of the user expires, changes, or is locked,
Microsoft Outlook Express does not prompt the user to enter the Connection password. The result is that
users do not receive voice messages from Connection.

Select Next.

On the Congratulations page, select Finish.

In the Internet Accounts dialog box, select the account that you created in Step 4, and select Properties.

In the <account name> Properties dialog box, select the IMAP tab.
Uncheck the Store Special Folders check box.
In the Root Folder Path field, enter INBOX (all upper-case letters).

If you do not want to encrypt voice messages and other data that are sent over the network between
Outlook Express and Connection, skip to Step 25.
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Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Novell GroupWise ||

A

Caution  If you do not configure Outlook Express to use SSL, the Connection username and password
that are sent to Connection over the network and the voice messages sent back from
Connection are not encrypted.

If you want to encrypt voice messages and other data that are sent between Outlook Express and
Connection, continue with Step 23.

Select the Advanced tab.
Under Incoming Mail, check the This Server Requires a Secure Connection (SSL) check box.
Select OK to close the <account name> Properties dialog box.

Select Close to close the Internet Accounts dialog box.

Creating and Configuring an Account to Access Cisco Unity
Connection 8.x in Novell GroupWise

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6
Step 7

Step 8
Step 9

To use GroupWise to access Cisco Unity Connection voice messages, create and configure a new
GroupWise account for the user. You need the following information:

¢ Connection username (alias).

e Cisco Personal Communications Assistant (PCA) password. (This is the web application password
that is set on the User pages in Cisco Unity Connection Administration.)

e The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in GroupWise

Start GroupWise.
On the GroupWise Tools menu, select Accounts > Account Options.
In the Accounts dialog box, select Add.

In the Create Account dialog box, in the Account Name field, enter a name for the account. This name
appears only in GroupWise.

In the Account Type list, select IMAP4.
Select Next.

In the Create Internet Account dialog box, in the Incoming Mail Server (IMAP4) field, enter the IP
address or the fully qualified domain name of the Connection server.

A

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured
for the network.

In the Login Name field, enter the Connection username.

In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Connection
server.
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Step10 In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the
Connection server. You can find this information in the SMTP Address field on the User Basics page in
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>
Step 11 In the From Name field, enter the username.
Step12  Select Next.
Step13  Follow the on-screen prompts to complete the configuration.

Step 14 If you do not want to encrypt voice messages and other data that are sent over the network between
GroupWise and Connection, skip to Step 20.

A

Caution  If you do not configure GroupWise to use SSL, the Connection username and password that
are sent to Connection over the network and the voice messages sent back from Connection
are not encrypted.

If you want to encrypt voice messages and other data that are sent between GroupWise and Connection,
continue with Step 15.

Step15 In the Accounts dialog box, select the name of the account that you just created.

Step16 Select Properties.

Step17 Select the Advanced tab.

Step18 Under Incoming Mail Server (IMAP4), check the Use SSL check box.

Step19  Select OK to close the <Account Name> Properties dialog box.

Step20 Select Close to close the Accounts dialog box.

Step21 Create the inbox for the new account, and download Connection voice messages:
a. In the left pane of GroupWise, select the name of the new account.
b. In the Logon to <AccountName> dialog box, enter the Cisco PCA password for the user.
c. Verify that the Remember Password check box is not checked.

If this option is checked, and the Connection password of the user expires, changes, or is locked,
GroupWise does not prompt the user to enter the Connection password. The result is that users do
not receive voice messages from Connection.

d. Select OK to close the Logon to <AccountName> dialog box.

e. With the name of the new account still selected in the left pane, on the GroupWise Tools menu, select
Send/Receive > This Folder.

Creating and Configuring an Account to Access Cisco Unity
Connection 8.x in Opera

To use Opera to access Cisco Unity Connection voice messages, create and configure a new Opera
account for the user. You need the following information:

e (Connection username (alias).
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Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7

Step 8
Step 9
Step 10
Step 11
Step 12
Step 13

Step 14

Step 15

Step 16
Step 17
Step 18

Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Opera ||

e (Cisco Personal Communications Assistant (PCA) password. (This is the web application password
that is set on the User pages in Cisco Unity Connection Administration.)

e The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Opera

Start Opera.

On the Opera Tools menu, select Mail and Chat Accounts.
In the Manage Accounts dialog box, select New.

In the New Account wizard, select IMAP.

Select Next.

In the Real Name field, enter the account name.

In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the
Connection server. You can find this information in the SMTP Address field on the User Basics page in
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>
In the Organization field, enter the applicable value.

Select Next.

In the Login Name field, enter the Connection username.

In the Password field, enter the Cisco PCA password.

Select Next.

In the Incoming Server field, enter the IP address or the fully qualified domain name of the Connection
server.

A

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured
for the network.

If you want to encrypt voice messages and other data that are sent between Opera and Connection, check
the Use Secure Connection (TLS) check box. (TLS is an updated version of SSL.)

A

Caution  If you do not configure Opera to use SSL, the Connection username and password that are sent
to Connection over the network and the voice messages sent back from Connection are not
encrypted.

In the Outgoing Server field, enter the IP address or the fully qualified domain name of the Connection
server.

Select Finish.
Select OK to close the Subscribe IMAP Folders dialog box.
Select OK to close the Manage Accounts dialog box.
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Creating and Configuring an Account to Access Cisco Unity
Connection 8.x in Thunderbird

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6

Step 7
Step 8
Step 9

Step 10
Step 11
Step 12
Step 13
Step 14
Step 15
Step 16

Step 17
Step 18

To use Thunderbird to access Cisco Unity Connection voice messages, create and configure a new
Thunderbird account for the user. You need the following information:

e (Connection username (alias).

e Cisco Personal Communications Assistant (PCA) password. (This is the web application password
that is set on the User pages in Cisco Unity Connection Administration.)

e The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Thunderbird

Start Thunderbird.

On the Thunderbird File menu, select New > Account.

In the Account wizard, on the New Account Setup page, select E-Mail Account.
Select Next.

On the Identity page, in the Your Name field, enter the username.

In the E-Mail Address field, enter the Connection SMTP Address of the user and the name of the
Connection server. You can find this information in the SMTP Address field on the User Basics page in
Cisco Unity Connection Administration. The E-Mail Address typically follows this format:

<alias>@<fully qualified domain name of the Connection server>
Select Next.
On the Server Information page, under Select the Type of Incoming Server You Are Using, select IMAP.

In the Incoming Server field, enter the IP address or the fully qualified domain name of the Connection
server.

A

Caution Do not use the fully qualified domain name of the Connection server unless DNS is configured
for the network.

Select Next.

On the User Names page, enter the Connection username.

Select Next.

On the Account Name page, enter a name for the account. This name appears only in Thunderbird.
Select Next.

On the Congratulations page, confirm that the settings are correct, then select Finish.

If you do not want to encrypt voice messages and other data that are sent over the network between
Thunderbird and Connection, you are finished creating and configuring a new account.

If you want to encrypt voice messages and other data that are sent between Thunderbird and Connection,
continue with Step 17.

In the left pane of Thunderbird, select the name of the account that you just created.

In the right pane of Thunderbird, under Accounts, select View Settings for This Account.
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Step 19
Step 20

Step 21

Creating and Configuring an Account to Access Cisco Unity Connection 8.x in Windows Mail for Windows Vista 1l

In the Account Settings dialog box, under the account that you just created, select Server Settings.

Under Server Settings, select the Use Secure Connection (SSL) check box.

A

Caution  If you do not configure Thunderbird to use SSL, the Connection username and password that
are sent to Connection over the network and the voice messages sent back from Connection
are not encrypted.

Select OK to close the Account Settings dialog box.

Creating and Configuring an Account to Access Cisco Unity
Connection 8.x in Windows Mail for Windows Vista

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9
Step 10
Step 11

To use Windows Mail for Windows Vista to access Cisco Unity Connection voice messages, create and
configure a new Windows Mail account for the user. You need the following information:

e Connection username (alias).

e Cisco Personal Communications Assistant (PCA) password. (This is the web application password
that is set on the User pages in Cisco Unity Connection Administration.)

e The IP address, or if DNS is configured, the fully qualified domain name of the Connection server.

To Create and Configure a New Account in Windows Mail

Start Windows Mail.

On the Tools menu, select Accounts.

In the Internet Accounts dialog box, select Add.

On the Select Account Type page, select E-Mail Account.

Select Next.

On the Your Name page, in the Display Name field, enter the username.
Select Next.

On the Internet E-Mail Address page, in the E-Mail Address field, enter the Connection SMTP Address
of the user and the name of the Connection server. You can find this information in the SMTP Address
field on the User Basics page in Cisco Unity Connection Administration. The E-Mail Address typically
follows this format:

<alias>@<fully qualified domain name of the Connection server>
Select Next.
On the Set Up E-Mail Servers page, under Incoming E-Mail Server Type, select IMAP.

In the Incoming Mail (POP3 or IMAP) Server field, enter the IP address or the fully qualified domain
name of the Connection server.

A

Caution In Step 11 and Step 12, do not use the fully qualified domain name of the Connection server
unless DNS is configured for the network.
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Step12  In the Outgoing E-Mail Server (SMTP) Name field, enter the IP address or the fully qualified domain
name of the Connection server.

Step 13  If the Connection SMTP server is configured to allow connections from untrusted IP addresses, skip to
Step 15.

If the Connection SMTP server is configured to require authentication from untrusted IP addresses,
continue with Step 14.

Step14  Check the Outgoing Server Requires Authentication check box.

Step15 Select Next.

Step16  On the Internet Mail Logon page, enter the user Connection alias and Cisco PCA password.
Step17  Select Next.

Step18 On the Congratulations page, select Finish.

Step19  Select Close to close the Internet Accounts dialog box.

Step20 If you do not want to encrypt voice messages and other data that are sent over the network between
Windows Mail and Connection, you are finished creating and configuring a new account.

If you want to encrypt voice messages and other data that are sent between Windows Mail and
Connection, continue with Step 21.

Step21 On the Tools menu, select Accounts.

Step22 In the Internet Accounts dialog box, select the name of the mail account that you just created and select
Properties.

Step23 In the Properties dialog box, select the Advanced tab.

Step24 Under both the Outgoing Mail field and the Incoming Mail field, check the This Server Requires a
Secure Connection (SSL) check box.

Step25 Select OK.

A

Caution  If you do not configure Windows Mail to use SSL, the Connection username (alias) and
password that are sent to Connection over the network and the voice messages sent back from
Connection are not encrypted.

Step26  Select Close to close the Internet Accounts dialog box.

Troubleshooting IMAP Client Sign-In Problems in Cisco Unity
Connection 8.x

When users change their Cisco PCA password (also known as the web-application password) in the
Cisco Unity Connection Messaging Assistant, they also must update the password in their IMAP client
application so that the client can continue to access Connection and retrieve voice messages.

If users have trouble receiving voice messages in an IMAP client, consider the following possibilities:

e If the IMAP client application prompts a user for the Cisco PCA password, but does not accept it,
the Cisco PCA password may have expired or changed, or is locked. Users can change their
password in the Connection Messaging Assistant first and then update it from their IMAP client
application.
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e If Microsoft Outlook users are not prompted for their Cisco PCA password, verify that the
Remember Password check box on the Internet E-mail Settings (IMAP) page is not checked. If this
option is checked, and the password of the user has expired, changed, or is locked, Microsoft
Outlook does not prompt the user to enter the Cisco PCA password. The result is that the user does
not receive voice messages from Connection, and Outlook prompts for the username and password.

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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User Orientation in Cisco Unity Connection 8.x

See the following sections:

Orientation Task List for Cisco Unity Connection 8.x Users, page 4-1

Settings That Cisco Unity Connection 8.x Users Can Change, page 4-3

Orientation Task List for Cisco Unity Connection 8.x Users

Revised November 16, 2010

After you set up the client applications that users will use to access Cisco Unity Connection from their
phones and computers, use the following task list to acquaint users with Connection. If you are planning
supplemental Connection training, also consider reviewing the potential user concerns and
misconceptions listed in the “Support Desk Orientation in Cisco Unity Connection 8.x” section on
page 5-2.

Offer User Documentation and Contact Information

1.

Give users a Cisco Unity Phone Menus and Shortcuts wallet card. Use the Wallet Card wizard to
produce the card. The templates in the wizard list frequently used menu options and shortcuts for
managing Connection messages and user preferences by phone; the wizard fills in the applicable
keys based on the conversation that you specify. The resulting PDF is formatted as a wallet card that
can be printed, then cut out and folded by users.

Procedures in the User Guide for the Cisco Unity Connection Phone Interface do not contain the
keys that users press for Connection menu options. Instead, the procedures use the prompts that
users hear to specify the menu options to choose. To provide users with key information, you must
use the Wallet Card wizard.

The Wallet Card wizard also allows you to customize technical support information and instructions
for signing in to Connection. The Wallet Card wizard is a Windows-based remote database
administration tool. Download the tool and view Help at
http://www.ciscounitytools.com/App_CUC_WalletCardWizard.htm.

Give each user applicable user guides. The following Cisco Unity Connection user guides are
available at http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html.

— User Guide for the Cisco Unity Connection Phone Interface
— User Guide for the Cisco Unity Connection Messaging Assistant Web Tool
— User Guide for the Cisco Unity Connection Messaging Inbox Web Tool

— User Guide for Accessing Cisco Unity Connection Voice Messages in an Email Application
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Orientation Task List for Cisco Unity Connection 8.x Users

— User Guide for the Cisco Unity Connection Personal Call Transfer Rules Web Tool
— Quick Start Guide: Using the Cisco Unity Connection Web Inbox
= Quick Start Guide: Using Cisco ViewMail for Microsoft Outlook

Information in the guides is generally organized by feature. You can distribute the guides for the
interfaces that users are using, or you can distribute feature-specific information to users for whom
you have enabled the features. (On Cisco.com, select the link for the topics you want, and print the
PDF files.)

Give users the phone numbers that they dial to access Connection from within your organization and
from outside the organization. As applicable, show users which button or key to use on their desk
phones to access Connection.

Give users the URL to the Cisco PCA website: http://<Cisco Unity Connection server
name>/ciscopca.

Give users the URL to the Cisco Unity Connection Web Inbox: http://<Cisco Unity Connection
server name>/inbox.

Give users the name, extension, and/or email address of the Connection administrator and any
support desk contact information.

Depending on the conversation version that users in your organization are familiar with, you may
want to provide them with a list of phone menu differences between Connection and a former voice
messaging system—especially if you choose not to offer them an alternative to the standard
conversation, which is specified by default in the Voice Mail User template.

Provide PINs, Passwords, and Security Guidelines

10.

1.

Provide users with their initial phone PINs. Alternatively, tell users to sign in to the Cisco Personal
Communications Assistant (PCA) website to set their phone PINs before they call Connection to
complete first-time enrollment. (Users are not required to enter an existing phone PIN in order to
change it in the Cisco PCA.)

If users choose not to initially change their PIN in the Cisco PCA, they are prompted to change their
phone PIN during first-time enrollment.

Provide users with their initial Cisco PCA passwords. Users must use the Connection Messaging
Assistant to change their Cisco PCA passwords.

Explain to users how to secure their phone and Cisco PCA PINs and passwords so that they
adequately protect their Connection mailboxes from unauthorized access. Detail the security
guidelines for your organization. Encourage users to enter secure PINs and passwords whenever
they change them.

Make sure users understand that their Cisco PCA passwords are not related to their Connection
phone PINs, nor are the passwords and PINs synchronized. Users may assume that their phone and
Cisco PCA PIN and password are the same. As a result, they may think that they are changing both
when the Connection conversation prompts them to change their phone PIN during first-time
enrollment. For this reason, you may find that many users do not consider securing their Cisco PCA
passwords, even though you request that they do so.

Remind Users to Complete First-Time Enroliment

12.

Make sure that users know that they need to complete first-time enrollment by phone. They do not
need to refer to any Connection documentation during enrollment. Connection indicates when the
enrollment process is complete. If users hang up before they have completely enrolled, none of their
changes are saved and the first-time enrollment conversation plays again the next time that they sign
in to Connection.
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The “Enrolling as a Cisco Unity Connection User” chapter of the User Guide for the Cisco Unity
Connection Phone Interface details the tasks that users are asked to complete as part of enrollment.

Explain How Connection Features and Functionality Work

13.

14.

15.

16.

17.

18.

19.

20.

Provide training on how to personalize user settings by using the phone and the Connection
Messaging Assistant, as summarized in Table 4-1. In particular, users may benefit from a hands-on
demonstration of the Messaging Assistant, as they may not be accustomed to using a web interface
to set voice messaging options.

Provide training on how to use the Cisco Unity Connection Personal Call Transfer Rules web tool,
and how call transfers, call holding and screening, and caller options are used, as summarized in
Table 4-2.

Users can refer to the User Guide for the Cisco Unity Connection Personal Call Transfer Rules Web
Tool or to Cisco Unity Connection Personal Call Transfer Rules Help for further guidance after
orientation.

Explain how full mailboxes work with Connection. See the “Support Desk Orientation in
Cisco Unity Connection 8.x” section on page 5-2 for issues that users may encounter. Refer users to
the appropriate user guides for similar information.

If single inbox is configured (Connection 8.5 and later only): Discuss single-inbox behavior with
users. For a detailed explanation of how single inbox works, including issues that may be of concern
to users, see the “Synchronizing Voice Messages in Connection and Exchange Mailboxes in

Cisco Unity Connection 8.5 and Later (Single Inbox)” section in the “Configuring Cisco Unity
Connection 8.5 and Later and Microsoft Exchange for Unified Messaging” chapter of the Unified
Messaging Guide for Cisco Unity Connection Release 8.5 and Later at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/unified_messaging/guide/85xcu
cumgx.html.

If your organization has users who will use RSS readers to access voice messages, provide training
on using RSS with Connection. See the “Configuring Access to RSS Feeds of Voice Messages in
Cisco Unity Connection 8.x” section in the “Messaging in Cisco Unity Connection 8.x” chapter of
the System Administration Guide for Cisco Unity Connection Release 8.x for details. The guide is
available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx
.html.

If your organization has users who will use TTY and the TTY prompt set, provide training on using
TTY with Connection.

Make sure that users who own call handlers or system distribution lists understand their
responsibilities (if applicable).

As applicable, tell users how to use the Cisco Unity Greetings Administrator and System Broadcast
Administrator.

Settings That Cisco Unity Connection 8.x Users Can Change

See the following tables:

Settings That Users Can Change By Using the Cisco Unity Connection Messaging Assistant and the
Phone Menus

Settings That Users Can Change By Using the Cisco Unity Connection Personal Call Transfer Rules
Web Tool and the Phone Menus
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Table 4-1
Menus

Settings That Users Can Change By Using the Cisco Unity Connection Messaging Assistant and the Phone

Settings That Can Be Changed by Using the Connection
Messaging Assistant

Settings That Can Be Changed by Using the Phone Menus

Call Holding and Screening:

e Select how Connection handles indirect calls when
the user phone is busy, including placing the caller on
hold, prompting the caller to hold or leave a message,
and sending the caller directly to the greeting

e Select how Connection handles indirect calls,
including telling the user who the call is for,
announcing that Connection is transferring the call,
prompting the user to accept or refuse a call, and
prompting callers to say their names

Call Holding and Screening:

e None

Call Transfers?:

e Configure the three basic transfer rules: standard,
alternate, and closed hours

e Enable or disable personal call transfer rules for each
of the basic transfer rules

e Transfer indirect calls to an extension or send them to
the user greeting

e Change extensions

Call Transfers?:

e Configure the three basic transfer rules: standard, alternate,
and closed hours

e Enable or disable personal call transfer rules for each of the
basic transfer rules

e Transfer indirect calls to an extension or send them to the
user greeting

e Change extensions

e Configure alternate contact numbers for caller input keys
that are assigned to the Transfer to Alternate Contact
Number action

Caller Options:
e Allow callers to edit messages

e Allow callers to mark messages urgent

Caller Options:

e None

Phone Menu Options:
e Set language for Connection prompts

e Specify whether users use the phone keypad or
voice-recognition input style

e Set speed and volume of prompts, recorded names,
and user greetings

e Select full or brief Connection conversation menus

e Select the action that Connection performs when the
user calls Connection, including greeting the user by
name, and announcing the number of new messages

by type
e Change the time format used for message time stamps

e Specify alternate extensions

Phone Menu Options:

e Select full or brief Connection conversation menus
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Table 4-1
Menus (continued)

Settings That Cisco Unity Connection 8.x Users Can Change

Settings That Users Can Change By Using the Cisco Unity Connection Messaging Assistant and the Phone

Settings That Can Be Changed by Using the Connection
Messaging Assistant

Settings That Can Be Changed by Using the Phone Menus

Greetings:
e Record a personal greeting
e Enable or disable greeting
e Specify an expiration date for an enabled greeting

e Switch between system prompt and personal greeting

Greetings:
e Record a personal greeting
e Enable or disable greeting

e Specify an expiration date for an enabled greeting

Message Notification:
e Enable or disable a notification device
e Specify dialing or recipient options

e Select the types of messages and message urgency for
which Connection generates a notification

e Specify a list of message senders (by username or
calling phone number) for which Connection
generates a notification

e Set up a notification schedule, and specify what
happens when a device does not answer, is busy, or
fails

Message Notification:

e Enable or disable a notification device, and change its
number

Message Playback:

e Specify the speed and volume of messages that are
played by phone

e Specify message playback order

e Specify whether Connection plays the Message Type
menu

e Select the action that Connection performs when
messages are played, including announcing the name
and number of the sender who left a message, and
whether the time stamp is played before or after the
message

e Specify that messages are marked saved upon
hang-up or disconnect

e Specify whether Connection asks to confirm deletions
of new and saved messages

Message Playback:

e Speed and volume of message as it is played
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Table 4-1 Settings That Users Can Change By Using the Cisco Unity Connection Messaging Assistant and the Phone
Menus (continued)

Settings That Can Be Changed by Using the Connection
Messaging Assistant Settings That Can Be Changed by Using the Phone Menus

Message Sending and Addressing: Message Addressing:

e Specify that Connection prompts to confirm message | ¢ Switch between addressing to other users by name or by
recipients by name extension (by pressing ##)

e Specify that Connection prompts to continue adding | ® Review, add, or remove names in the addressing priority list*
names after each recipient

e Specify that Connection sends messages when users
hang up or a call is disconnected

e Switch between addressing messages to other users
by name, or by extension

e Specify order for addressing messages by name (last
name then first name, or vice versa)

Personal Settings: Personal Settings:
e Record a name e Record a name
e Specify alternate names e Change directory listing status
e Change directory listing status e Change password or PIN
e Change password or PIN e Add user-defined alternate extensions’
e Add user-defined alternate extensions’ e Edit alternate contact numbers, if an administrator has

configured one or more caller input keys to transfer to an
alternate contact number during the user greeting

Private Lists: Private Lists:
e Enter a display name e Record a list name
e Record a list name e Add and delete members

e Add and delete members

Contacts: Contacts:

e Set up contacts to use for both name dialing and call | ¢ None
transfer rules

1. Call holding and screening options apply only to incoming calls that were routed to the user from the automated attendant or a directory handler, and not
on direct calls. Holding and screening options do not apply when an outside caller or another user dials a user extension directly. In addition, holding and
screening options are only available when supervised transfers are enabled. These settings apply if the user does not have personal call transfer rules
enabled.

2. Call transfer options apply only to incoming calls that were routed to the user from the automated attendant or a directory handler, and not on direct calls.
Transfer options do not apply when an outside caller or another user dials a user extension directly.

Note that this depends on whether you have enabled spelled name addressing.

4. To enable users to access the setup conversation that allows them to review, add, or remove names in the addressing priority list, the users must be
assigned to a custom conversation, and you must use the Custom Keypad Mapping tool to map the Addressing Priority List conversation to a key in the
Message Settings menu for that conversation.

5. Users must belong to a class of service with the Allow Users to Manage Their User-Defined Alternate Extensions option enabled. To enable users to
access the phone menu conversation that allows them to review, add, or remove alternate extensions, the users must be assigned to a custom conversation,
and you must use the Custom Keypad Mapping tool to map the Edit User-Defined Alternate Extensions option to a key in the Preferences Menu for that
conversation.
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Table 4-2 Settings That Users Can Change By Using the Cisco Unity Connection Personal Call Transfer Rules Web

Tool and the Phone Menus

Settings That Can Be Changed by Using the Cisco Unity
Connection Personal Call Transfer Rules Web Tool

Settings That Can Be Changed by Using the Phone Menus

Call Holding and Screening:

e Set up personal call transfer rules to specify how
Connection handles direct and indirect calls when the
user phone is busy, including placing the caller on
hold, prompting the caller to hold or leave a message,
and sending the caller directly to the greeting

e Set up personal call transfer rules to specify how
Connection handles direct and indirect calls,
including telling the user who the call is for,
announcing that Connection is transferring the call,
prompting the user to accept or refuse a call, and
prompting callers to say their names

Call Holding and Screening:

e None

Call Transfers:

e Set up personal call transfer rules to transfer direct
and indirect calls to an extension, to an external phone
number, or to the greeting

Call Transfers:

e Enable or disable personal call transfer rules to transfer
direct or indirect calls to an extension, to an external phone
number, or to the greeting

¢ Enable or disable the Transfer All rule set to forward all calls
to voicemail or to another phone number

e Forward all incoming calls directly to Connection, rather
than to phone extension

Caller Options: Caller Options:
e Allow callers to edit messages e None
e Allow callers to mark messages urgent

Destinations: Destinations:
e Set up phone numbers or notification devices to use e None

when transferring calls

e Set up groups of destinations to use in personal call
transfer rules

e Specify the number of rings that Connection waits
before transferring the call to the next destination or
to voicemail

Caller Groups

e Create groups of user-defined contacts,
administrator-defined contacts, or Connection users
to use in personal call transfer rules

Caller Groups

e None
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CHAPTER

Operator and Support Desk Orientation in
Cisco Unity Connection 8.x

Operators in your organization need information about Cisco Unity Connection that is specific to your
installation. In addition, if your organization has a support desk, the staff need to be prepared to answer
the questions that users may ask, and to be aware of the resources that are available to assist them in
answering user questions.

See the following sections:
e Operator Orientation in Cisco Unity Connection 8.x, page 5-1

e Support Desk Orientation in Cisco Unity Connection 8.x, page 5-2

Operator Orientation in Cisco Unity Connection 8.x

Operator orientation should address the same points as user orientation, but in greater detail. Operators
must be familiar with how users use Cisco Unity Connection. Depending on the size of your
organization, the operator may be the person users are likely to ask when they have questions about
Connection.

In addition to the information in the “User Orientation in Cisco Unity Connection 8.x” chapter and the
“Support Desk Orientation in Cisco Unity Connection 8.X” section on page 5-2 (as applicable),
operators also need to understand the following concepts and tasks.

Roles of the Operator and the Automated Attendant

The way your organization uses the automated attendant determines what the operator responsibilities
are. The automated attendant is a call handler that is used in place of a human operator to answer and
direct calls by playing greetings and responding to caller input. The automated attendant can provide a
menu of options (for example, “For Sales, press 1; for Service, press 2.”), and it can also provide
information (for example, “Our normal business hours are Monday through Friday, 8 a.m. to 5 p.m.”).

Directing Calls

Regardless of how your organization uses the automated attendant, many calls go to the operator. The
operator must know how to direct calls to voicemail and to user phones. With Cisco Unified
Communications Manager, you can program the phone to direct calls to voicemail. For details on setting
this up, see the tech note How to Transfer a Caller Directly into a Cisco Unity Mailbox, available at
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_tech_notes_list.html.
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Forwarding Messages to Intended Recipients

If an operator also owns a call handler or system distribution list, make sure that the operator knows to
review messages frequently, and to forward messages as necessary to the applicable recipients.

Using the Cisco Unity Greetings Administrator

An operator who is responsible for changing call handler greetings for the organization can use the
Cisco Unity Greetings Administrator when it is not practical to change a greeting in Cisco Unity
Connection Administration. For example, if the office is unexpectedly closed because of bad weather,
the operator can call from home to use the Cisco Unity Greetings Administrator to enable the alternate
Opening Greeting, or to rerecord a call handler greeting stating that the office is closed. See the “Using
the 8.x Cisco Unity Greetings Administrator to Record or Rerecord Call Handler Greetings” section in
the “Managing Recorded Greetings and Recorded Names in Cisco Unity Connection 8.x” chapter of the
System Administration Guide for Cisco Unity Connection Release 8.x for instructions, at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.htm
1.

Using the Cisco Unity Broadcast Message Administrator

If an operator is responsible for sending recorded announcements to everyone in an organization (or to
particular locations within an organization), explain how to access and use the Cisco Unity Broadcast
Message Administrator to send broadcast messages. See the “Setting Up Broadcast Messaging in
Cisco Unity Connection 8.x” chapter of the System Administration Guide for Cisco Unity Connection
Release 8.x for instructions, at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.htm
L.

Support Desk Orientation in Cisco Unity Connection 8.x

Support desk orientation should address the same points as user and operator orientation, but in greater
detail. Support desk staff must be familiar with how users and operators use Cisco Unity Connection,
and the common problems that users may encounter when using Connection. Instead of using the
Connection server, it may be helpful to set up a test server that support desk staff can use to browse to
Cisco Unity Connection Administration, and troubleshoot and test client applications.

To prepare for possible calls to the support desk at your organization, familiarize the support desk staff
with the resources listed in the following “Support Desk Resources” section, and with the potential user
concerns and misconceptions listed in the “Potential User Concerns and Misconceptions” section on
page 5-3. (See also the“Operator Orientation in Cisco Unity Connection 8.x” section on page 5-1 and
the “User Orientation in Cisco Unity Connection 8.x” chapter.)

Support Desk Resources

e User documentation is available at
http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html.

e The Compatibility Matrix: Cisco Unity Connection and the Software on User Workstations is
available at
http://www.cisco.com/en/US/products/ps6509/products_device_support_tables_list.html.

User Workstation Setup Guide for Cisco Unity Connection Release 8.x

0L-21539-01


http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html
http://www.cisco.com/en/US/products/ps6509/products_device_support_tables_list.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsag150.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsag220.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsag220.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/administration/guide/8xcucsagx.html

| Chapter5 Operator and Support Desk Orientation in Cisco Unity Connection 8.x

Support Desk Orientation in Cisco Unity Connection 8.x [l

e The following chapters in this guide provide information on how user workstations should be set up,
and describes how users use Connection client applications:

— Setting Up Access to the Cisco Personal Communications Assistant in Cisco Unity Connection
8.x

— Setting Up Playback and Recording Devices for the Media Master in Cisco Unity Connection
8.x

— Configuring an Email Account to Access Cisco Unity Connection 8.x Voice Messages

e The Troubleshooting Guide for Cisco Unity Connection Release 8.x is available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/troubleshooting/guide/8xcuctsg
x.html.

e For descriptions and the URLSs of all Connection documentation on Cisco.com, see the
Documentation Guide for Cisco Unity Connection Release 8.x. The document is shipped with
Connection and is available at
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/8x/roadmap/8xcucdg.html.

Potential User Concerns and Misconceptions

Revised November 16, 2010

Table 5-1 describes potential user issues, which are typically based on misconceptions about how
Cisco Unity Connection works. Users who encounter such issues are often those who are accustomed to
another voice messaging system, have not yet completed Connection training, or are unaware of a new
feature or functionality change to an existing system.

Table 5-1 Potential User Concerns and Misconceptions

Potential Issue

Description

Delayed messages

Users may believe that their messages are delayed for the following reasons:

e While listening to new messages, users may skip a message and inadvertently mark it new.
Later, when they check messages again, they hear the skipped message and believe that the
message arrived after a delay.

e Users may skip more messages than they intend while listening to their messages, and later
check messages again only to hear one or more of the skipped messages, and believe that the
messages arrived after a delay.

e While listening to messages, other new messages arrive that users may not be aware of. Later,
when they check messages again, they hear the new messages and believe that they were
delayed.

Deleted messages

By default, when users delete a new or saved message, Cisco Unity Connection does not ask them
to confirm the deletion. You may want to enable Connection to request confirmation from users
before proceeding with the deletion, especially if many users do not belong to a class of service that
allows them to retain and review their deleted messages. You can set up Connection to confirm
deletion of messages on the System Settings > Advanced > Conversations page in Cisco Unity
Connection Administration.

For information on deleted messages, refer users to the “Deleting Messages” chapter of the User
Guide for the Cisco Unity Connection Phone Interface, available at
http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html.
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Table 5-1

Support Desk Orientation in Cisco Unity Connection 8.x

Potential User Concerns and Misconceptions (continued)

Potential Issue

Description

Deleted messages:
IMAP and MAPI
behavior

When users access messages stored on a Microsoft Exchange server both from a Microsoft Outlook
client and from Cisco Unity Connection, they may experience unexpected and confusing behavior
when deleting messages. The difference in behavior occurs when the Microsoft Outlook client is
configured to use MAPI, the Microsoft interface for connecting to Exchange, and stems from the
fact that MAPI and IMAP—the protocol used by Connection—use different mechanisms for
marking messages as deleted.

If you have users who access a Microsoft Exchange server by using Outlook (with MAPI) or
Outlook Web Access, and who also use Connection to manage messages on the same message store,
be sure to alert them to this behavior.

Deleted Messages—IMAP Behavior

When a user deletes a message from Microsoft Outlook, the message is moved from the Inbox to
the Deleted Items folder. At this point, Connection can no longer access the message, and no longer
indicates that the message exists either as a new, saved, or deleted message.

Deleted Messages—MAPI Behavior

When a user deletes a message from Connection, the message remains in the Inbox but is flagged
to indicate that it has been marked deleted by the user. However, when configured to use MAPI,
Microsoft Outlook does not recognize this flag as a deletion, and continues to display the message
as a new or saved message in the Inbox.

Device for recording or
playback does not show
in ViewMail for

Outlook device lists (in
ViewMail 8.5 and later)

When users add or turn on a new recording or playback device, they must restart the ViewMail for
Outlook add-in so it can recognize the new device. To restart ViewMail, restart Outlook.

Directory listing: users
are not listed as
expected

When users do not have a recorded name, they are not listed in the corporate directory and as a
result, outside callers are not be able to find them when searching for them by name. By default,
Cisco Unity Connection prompts users to record a name during first-time enrollment, but it does
not prevent them from completing the enrollment process if they do not.

To address this issue, consider the following options:

* You can change whether recording a name is required to complete first-time enrollment on the

System Settings > Advanced > Conversations page in Cisco Unity Connection Administration.

® You can provide recorded names for users in Cisco Unity Connection Administration.

e Users with class of service rights can record their own names by using the Connection
conversation or the Connection Messaging Assistant.

Note  This problem does not occur for internal users, but only for outside callers; Connection
users who address messages by name are still able to find other users even if they have not

recorded a name.

Fax: attached files are
not delivered to fax
machines

(fax integrations only)

Users may be unaware that when they add attachments to an email message and then send the
message to a fax machine, Connection renders only those attachments with the file extensions
specified during Connection setup. All other attachments are removed.

l_ User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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Table 5-1 Potential User Concerns and Misconceptions (continued)

Potential Issue Description

IMAP client: Users who use different third-party IMAP clients to access voice messages from their desktop
Differences in client machines may note the following discrepancies in behavior:

behavior

e Microsoft Outlook client:

— For new messages, the “Mark as Unread” feature marks messages as new on the
Cisco Unity Connection server, regardless of whether the WAV file message attachment is
downloaded or not.

— Voice messages that are deleted by phone are marked for deletion in the Outlook client and
are changed to strikethrough text when users select the “Send/Receive” command.

e Novell GroupWise client:

— When new messages with the WAV file message attachment have been downloaded to the
GroupWise client, the “Read Later” feature no longer marks the message as new on the
Connection server.

— Voice messages that are deleted by phone are not marked for deletion in GroupWise; users
need to manually delete them from this client.

— GroupWise users need to use the “Send/Retrieve” command to update message status from
the Connection server.

Mailbox fills up quickly |Users may complain that their mailboxes are filling up too quickly, for any of the following reasons:

e Cisco Unity Connection does not automatically delete messages when they reach a certain age.
This means that user messages are saved until the user deletes them permanently. (For
information on how to permanently delete messages, refer users to the “Managing the Size of
Your Mailbox” chapter of the applicable user guides available at
http://www.cisco.com/en/US/products/ps6509/products_user_guide_list.html.)

e When users receive nondelivery receipts (NDRs) to messages that they send, their email client
mailbox can quickly increase in size—especially if the original message included large
attachments. For users who have access to email messages via TTS, if their email clients are
configured to save their sent messages, the original message and attachments are stored in their
Sent Items folders and another copy is sent to their Inboxes along with the NDR, increasing
their mailbox size accordingly.

e Users may receive messages that have been forwarded many times over, which increases
message size. The original message plus all recorded introductions that were added during
forwarding equal the total message size. As a result, users who have relatively few messages
stored in their mailboxes may still find that their mailboxes exceed the storage limits.

e User mailboxes can fill up while users are on vacation or on an extended leave of absence. To
prevent this, specify that Connection prevents callers from leaving messages when users have
their alternate greetings enabled.

Message notification: When a user chooses not to have Cisco Unity Connection restart notification each time a new
repeat notification message arrives, setting a long interval between repeat notification calls may lead the user to believe
options that Connection is delaying notification.

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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Potential User Concerns and Misconceptions (continued)

Potential Issue

Description

Media Master: opening
a file that is saved on a

When a user attempts to use a previously recorded WAV file (for example, an announcement that
was recorded earlier) rather than recording by using a phone or a computer microphone, the Media

workstation Master may display an error message. The error occurs when the WAV file was recorded in the
G.729a audio format. To resolve the problem, the user must do one of the following:
e Convert the WAV file to another audio format (for example, convert it to the G.711 audio
format).
e Use a WAV file that is recorded in a supported audio format other than G.729a.
e Make the recording by using a phone or a computer microphone.
MWIs To gain an understanding of when MWIs turn on and off, what causes them to turn on and off, and

what causes MWIs to behave differently than expected, see the “Troubleshooting Message Waiting
Indicators (MWIs) in Cisco Unity Connection 8.x” chapter of the Troubleshooting Guide for
Cisco Unity Connection Release 8.x.

Passwords and PINs are
not secure, or users use
the wrong password or
PIN

Users may assume that their phone PINs and Cisco Personal Communications Assistant (PCA)
passwords are the same or are synchronized. As a result, they may think that they are changing both
PIN and password when Cisco Unity Connection prompts them to change their phone PIN during

first-time enrollment. Additionally, they may try to use their phone PIN to sign in to the Cisco PCA.

Speed for elements of
the Connection
conversation varies

Users may report that the speed at which Cisco Unity Connection plays menus, recorded names,
greetings, and messages is inconsistent. For example, users may report that when they listen to their
messages, the message is played at a different speed than the recorded names of users who leave
them messages and the message properties (for example, the time stamp and message number).

Such inconsistencies are expected when you consider the following:

e Connection plays recorded names and greetings at the speed at which they were recorded.
Neither you nor users can affect the playback speed of recorded names and greetings.

e Messages played via Text to Speech (TTS) are always played at normal speed by default,
regardless of message playback settings.

e The speed that you or a user specifies for system prompts—the standard recordings that come
with the Connection system, including prompts for message properties—does not affect the
playback speed of messages.

e The speed that users specify for message playback does not affect system prompts.

Unread messages

Depending on how Cisco Unity Connection is set up at your organization, users may be surprised
at how Connection handles messages when calls are intentionally or unintentionally disconnected
(for example, when a user hangs up or when a mobile phone loses its charge or signal) while users
are in the process of listening to new messages. Some users may incorrectly assume that Connection
marks the message as read, which is not the case.

You can change how Connection handles unread messages when calls are disconnected by adjusting
the “Mark Message Saved If User Hangs Up” setting on the System Settings > Advanced >
Conversations page of Cisco Unity Connection Administration.
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Table 5-1 Potential User Concerns and Misconceptions (continued)
Potential Issue Description
Unsent messages Depending on how Cisco Unity Connection is set up at your organization, users may be surprised

at how Connection handles messages when calls are intentionally or unintentionally disconnected
(for example, when a user hangs up or when a mobile phone loses its charge or signal) while users
are in the process of sending, replying to, or forwarding a message. Some users may incorrectly
assume that Connection offers a draft folder for unsent messages, which is not the case.

You can change how Connection handles unsent messages when calls are disconnected by adjusting
the “Send Message If User Hangs Up During Recording” setting on the System Settings >
Advanced > Conversations page of Cisco Unity Connection Administration.

User Workstation Setup Guide for Cisco Unity Connection Release 8.x
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